RMC tutorial



1. Install WinNFLP
Unzip NFLP_windows.zip (extract to C:¥)

Contents of NFLP windows folder

Calibration NA

Correct NA — fz::)ﬁ :
Documentation Documentation of RMCA etc. "; |
Examples Exapmles r EA
Jmol-14.0.10 Jmol (visualize atomic configuration) ww
Rmec executable code

Tables

Templates B — sremneseens
UsefulAnalyzeCfg Tools to analyze atomic configuration file

UsefulAnalyzeScfg

UsefulCfg Tools to create/modify configuration files

UsefulData Tools to analyze RMC data

UsefulPlot Tools to plot RMC data

readme.txt

RMCA.ini

WinNFLP.exe GUI tools

WinNFLP.ini

Jdmol requires Java SE Development Kit 7



Execute WinNFLP
Double click WinNFLP.exe in NFLP_windows folder
Dialog “Select Acrobat Reader”
Select Adobe Reader folder and “open” or “cancel”

Dialog “Select any file in desired working directory”

Select »NFLP_windows» ExamplesP RMCA_MCGR»rmca_hgrhg.dat and open

[Practice 1 : model structure of liquid mercury])
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Model the structure of liquid mercury on the basis of x-ray S(@) by RMC.
Create a random configuration, moveout closest atom, perform RMC, and analyze atomic configuration.
Open »NFLP_windows»ExamplesP RMCA_MCGR»rmca_hg folder to access files in the folder.

It is better to set the environment of Windows to show extension of files.

Create a random configuration

1" C:¥NFLP_windows¥UsefulCfg¥random.exs —

Execute Useful > CFG programs>Random

Number of Euler angles >0

Number of particle types > 1 < single component system = 1

Number of particles of type 1 > 2000

Density > 0.04063 < atomic number density of mercury, / A3
Output file [.cfg] > hg < name of .cfg file



Moveout the atoms within closest approaches

Execute Useful > CFG programs>MoveOut

MOVEOUT

Starting configuration

Closest approaches

1907 atoms of type 1 have too
Move atoms of type 1 ? (T/F)

Maximum move

Max. no. of iterations
1907 atoms of type 1 have too
after***x** jterations

364 atoms of type 1 have too
after***** jiterations

Continue ? (T/F)

.

0 atoms of type 1 have too
after***** jiterations
Re-calculate neighbours? (T/F)
Change cut-offs ? (T/F)

Output file

hg
2.6

close neighbours
t

: 3

: 1000000

close neighbours

close neighbours

s t

close neighbours

Hh Hh

TT 11

T

T

i ° C:¥NFLP_windows¥UsefulCfg¥moveout.exe

file name of cfg file created by random

2.6 A determined by experimental g(r)

number of particle 1 which do not satisfy closest approaches
move particle 1 or not?

maximum distance (is necessary to change at random)

repeat the process to reach 0 atoms by changing maximum move
finish moveout
don’t re-calculate

don’t change cut-offs
save file (overwrite)



Visualization of atomic configuration

Execute Useful > Plot programs > ConfPlot

# ' ConfPlot

File Edit View State Window Help

%] PGPlot Graphics, # 1 = =
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ConfPlot 2.5
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Current plot size is (cm) 18.96660 14.50273
> open hg

Reading file : hg.cfg
Configuration contains
> plot

Plotting configuration: hg.cfg
PLEASE WAIT..

Current plot size is (cm)

200 atoms of 1 types.

15.088672 22.442188

Type: 1

7 | confPlot

< open “hg.cfg”

<— type “plot” for visualization



% hg.cfg file (atomic configuration data)

(Version 3 format configuration file)
Random configuration

0 0 0 moves generated, tried, accepted
0 configurations saved

2000 molecules (of all types)
1 types of molecule
1 is the largest number of atoms in a molecule
0 Euler angles are provided

F (Box is not truncated octahedral)
Defining vectors are:
18.324457 0.000000 0.000000
0.000000 18.324457 0.000000
0.000000 0.000000 18.324457

2000 molecules of type 1
1 atomic sites
0.000000 0.000000 0.000000

-0.5556233 -0.7685104 -0.5371170
-0.8435115 -0.1586675 -0.9489551
0.2504269 -0.2151476 -0.3068128

«— title

<« history of RMC

< number of all particles

< information of simulation box

< side length of the simulation box

< fractional coordinates (x, y, z) -1 <xyz <1



% hg.dat (control file)
Liquid Hg@RT

0.04063
2.6
0.25

0 0.0
0.05
.false.
0

9000 1
10 1
0100
hgsqg.dat
1 381

1 !
3 0.01
.false.
.false.
1.0
.false.
1

0.
.false.

o O O o

.false.

Coefficients

number density

maximum move

nswap,swapfrac

r spacing

whether to use moveout option

number of configurations to collect

step for printing,plotting

Time limit, step for saving

No. of g(r), neutron, X-ray, EXAFS expts

Range of points used

isig,Standard deviation

whether to renormalize
beta

whether to offset
nback

bcoeff

no. of coordination constraints

no. of average coordination constraints
no. of bvs constraints

no. of triplet constraints

whether to use a potential

«— title
< number density As
< closest distance

< maximum movement

< rstep

< number of experimental data
— file name of x-ray S(Q)



6.

v

Final RMC modeling with x-ray S(Q)
Execute Rmc>RMCA
Dialog “Select a file” , open hg.dat
Then RMC will be automatically initialized

() Black: experimental X-ray S(§)
Red: calculated S(@) by RMC
- Chi2 Black: total x 2

Red: 2 of S(Q)
+ Gpartial(») Black: Partial g(r)

« RMCA Info window

Scroll down the window and you will find

Begin (Y/N)?

Type “y” for start of RMC

To control RMC run
Status >Pause (Ctrl+S)  Pause RMC
Status >Resume (Ctrl+Q) Repause RMC
File >Save Save the results of RMC
File > Exit Quit RMC

It is necessary to run to converge the yx 2

I[ Fle Edit plot Status Windows Help

T15(Q)

st

Cpemmn
e

IR e

. jwwwwwu__ .

a
@it

4

= chi2 (== =

k!l
i
&
k3
i

B Gpartial(r)

e

5/ RMCA Info =N =R

-1 26U A

Maximum chanze in any coordinate ic 0.25004 for part

Using 366 r points spaced at 0.0504 up to 18.3004

Ho. of confizs to save 0

Writing sunmary every 9000 sererated moves

Programme will run for  60.0 minutes savine every

Fitting to 1 3(0)'s with constant coefficients

]

b

BEfRP  [fouf pending in RMCA Tnfo




v

To plot the results of RMC
Execute Useful > Plot programs >RMCPlot
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RMCPlot 1.0
R SR SR R R R R SR R S S R S R R R R R S SR R R R R S SR S S S R S S S
File to plot (or RETURN to exit) > hg.out
Input file contains 3 groups of plots:
Group 1 contains 1 plots of 1 curves
Group 2 contains 1 plots of 1 curves
Group 3 contains 1 plots of 2 curves
Plot which group (enter 0 to exit) 2?2 1
Change limits ? (T/F) > t
Data limits are

5.0000001E-02 18.30000 0.0000000E+00
2.913868

Current plotting limits are :

-0.8625000 19.21250 -0.1456934
3.59561

Enter new limits > 0 20 0 3

e

W File Edit View State Window Help
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RMCP1ot 1.0
RO OO K

File to plot (or RETURN to exit) > he.outll

«— “hg.out” contains g(r) and S(Q) calculated by RMC together with
experimental data

«— Group 1 : partial gi{r)

«— Group 2 : partial Si{Q)

«— Group 3 : S(Q)s

«— Select Group 1

< tochange X axis : 0~20, Y axis : 0—~3

It is necessary to make dure the first coordination distance in g(r), which should be found at around 4.5A



Calculation of the distribution of coordination number 3 C:¥NFLP_windows¥UsefulAnalyeeCTgvnentio oxn

Execute Useful > Analyze CFG programs > NextTo

No. of sets > 1

Configuration file > hg < select hg.cfg
Distances from central particle > 4.5 < input the first coordination distance
Output file > hg < output to “hg.nei”

v Open hg.nei by text editor to see the distribution of coordination number of Hg around Hg within 4.5 A

9.

Calculation of Hg'Hg'Hg triplet angle 1 | C:¥NFLP_windows¥UsefulAnalyzeCfg¥triplets.exe

Execute Useful > Analyze CFG programs > Triplets

No. of theta pts > 180

(A)ngle or (C)osine distribution [C] > a < Angle or Cosine

Max. no. of neighbours for bond ang (0 for all) > 0

No. of sets > 1

No. of configurations > 1

Configuration file(s) [.cfg*] > hg < input the file name of .cfg
Minimum r values (npartial values) > 0

Maximum r values (npartial values) > 4.5

Processing hg.cfg

Set output file [.pct] > hg



Execute Useful > Plot programs >RMCPlot
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RMCPlot 1.0

R SR SR R S R SR R R R R R S R R R R R S R R R R R S R R S S S S R S
File to plot (or RETURN to exit) > hg.pct
Change limits ? (T/F) > t
Data limits are

173.9578 6.042285 0.0000000E+00 0.8882140

Current plotting limits are :

-2.353492 182.3536 -4.4410702E-02 0.9326247

Enter new limits > 0 180 0 1

E RMCPlot - [RMCPlat.

] File Edit View State Window Help
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RMCPlot 1.0
FER RO R

File ta plot (or RETURN to exit) > he.pctll

< select “hg.pct”
< change plot range

< change x-axis: 0—~180, y-axis: 0—~1



[Practice 2 : model the structure of SiO, glass]

Preparation
Execute WinNFLP.exe
Dialog “Select any file in desired working directory

Select »NFLP_windows» Examples>RMCA_MCGR»rmca_sio2»sio2.dat

v' Model the structure of SiOsglass by using a combination of neutron S(Q) and x-ray F(§)
v" The order is Random, MoveOut, Hard Sphere Monte Carlo (HSMC) simulation to create a Q* network, RMC simulation, and analysis of

RMC configuration.

1. Create a random configuration

Execute Useful > CFG programs>Random

Number of Euler angles >0

Number of particle types > 2 < 2 atomic type, Siand O

Number of particles of type 1 > 550 < number of Si atom: 550

Number of particles of type 1 > 1100 O atom: 1100

Density > 0.06615 —atomic number density of SiOz (A3) which can be calculated by a

mass density
Output file [.cfg] > sio2



Moveout the atoms within closest approaches

Execute Useful > CFG programs>MoveOut

MOVEOUT
Starting configuration : sio2
Closest approaches : 2.9 1.5 2.4

524 atoms of typesl have too close neighbours
1037 atoms of types2 have too close neighbours

Move atoms of type 1 ? (T/F) : t

Move atoms of type 2 ? (T/F) : t

Maximum move : 3

Max. no. of iterations : 1000000
C e (BWE) - e -

0 atoms of typesl have too close neighbours
after***** jterations
Re-calsulate neighbours? (T/F) : f
Change cut-offs ? (T/F) : £
Output file : sio2

«— input the file name of initial configuration created by random

« closest distance for Si-Si, Si-O, and O-O

< move type 1 (S1)
<~ move type 2 (O)
< distance for maximum move

Perform Hard Sphere Mote Carlo (HSMC) simulation (RMC w/o experimental data) and RMC simulation

Constraints experimental data Coordination number (CN) constraints Where in .dat file
(1) Neutron S() siogemsq.dat line 13~23
(2 X-ray S(Q) sio04sq.dat line 24~33
3 Four fold Si CN of O around Siin 0 < r< 1.84 should be 4 line 35
4) Two fold O CN of Si around O in 0 < r< 1.8& should be 2 line 36
(5) zero fold Si (optional) CN of O around Siin 1.8 < r< 2.24 should be 0 line 37




It is important point that we need preliminary HSMC run to create Q4 network by interconnestion of Si04 tetrahedra with sharing
oxygen at the corner before final RMC run with both neutron and x-ray S(€). In HSMC run, we use only constraints (3) and (4) in the

table above.

v Copy original “sio2.dat” to “sio2.dat_orig”.
v Open “sio2.dat” by a text editor
Modify the description of experimental data in line 12 0110 - 0000
Delete the description for neutron S(€) in line 13~23
Delete the description for x-ray F(Q) in line 24~33
Modify the description for CN constraints in line 34 3 — 2

Delete the description for CN constraints in line 37

Si02 network (hard sphere MC)

0.06615 ! number density
2.90 1.50

2.45 ! cut offs
0.25 0.25 ! maximum move
0 0.0 ! nswap,swapfrac
0.05 ! r spacing
.false. ! whether to use moveout option
0 ! number of configurations to collect
9000 1 ! step for printing,plotting
60 10 ! Time limit, step for saving
0000 ! No. of g(r), neutron, X-ray, EXAFS expts < no experimental data in a HSMC run
2 ! no. of coordination constraints «— modify the number of CN constraints
120. 1.8 4 1. 0.00001 — CN of O around Si in 0~1.8A should be 4
210. 1.8 2 1. 0.00001 «— CN of Si around O in 0~1.8A should be 2
0 ! no. of average coordination constraints
0 ! no. of bvs constraints
0 ! no. of triplet constraints

|

.false. whether to use a potential



To start a HSMC run,
Exectute Rmc>RMCA
Dialog “Select a file” , open sio2.dat
In “RMCA Info” window
Scroll down the window and you will find
Begin (Y/N)?

Type “y” for start of final RMC run

It will take time to satisfy coordination number constraints (to be explained in detail in tutorial).

Final RMC run
Preparation

Delete “sio2.dat” and rename “sio2.dat_orig” to “sio2.dat”

To plot the results of RMC run
Execute Useful > Plot programs >RMCPlot and plot “sio2.out”

It is necessary to make sure the first coordination distance for Si-Si, Si-O, and O-O which should be found at around 3.5, 1.8, and 3.0A,

respectively.

To visualize atomic configuration, execute Useful > Plot programs > ConfPlot

To bond Si and O by a line,

> bond 1 2 0 1.8
> plot



6. BAL L oy AT O fibir
Useful >Analyze CFG programs > NextTo Z L L £ 7,

No. of sets > 1

Configuration file > sio2
Distances from central particle > 1.8 1.8
Output file > sio2 < output to “sio2.nei”

7. Analysis of bond angle distributions
Execute Useful > Analyze CFG programs > Triplets

No. of theta pts > 180

(A)ngle or (C)osine distribution [C] > a

Max. no. of neighbours for bond ang (0 for all) > 0
No. of sets > 1

No. of configurations > 1 < number of configuration (should be 1)
Configuration file(s) [.cfg*] > sio2

Minimum r values (npartial values) > 0 0 0 < minimum distance for Si-Si, Si-O, and O-O pairs
Maximum r values (npartial values) > 3.5 1.8 3.0 < maximum distance for Si-Si, Si-O, and O-O pairs

Processing sio2.cfg
Set output file [.pct] > sio2 < fine name for output

v To plot bond angle distributions
Execute Useful > Plot programs >RMCPlot

File to plot (or RETURN to exit) > sio2.pct <—select si02.pct Upper : Si-Si-Si, Si-Si-O, 0-Si-O
Lower : Si-O-Si, Si-O-O, 0-0-0O

8. Analysis of ring statistics

Execute Useful > Analyze CFG programs > Rings



Configuration file [.cfg] > sio2
Binary network ? [T/F] > t
Which types > 1 2

Output file name [.rng] > sio2

type 1(Si) and type 2 (O)

output file name is “sio2.rng”

maximum size of ring is set to 12

first coordination distance for Si-O is 1.8 A
name of output file is “si02.rst”

Maximum ring size > 12
Maximum distance between neighbours > 1.8

TT 11

Detailed statistics output y/[n]? >y

9. Convert .cfg file to a RasMol file
Execute Useful > Plot programs>RasMolConv

Enter input file name [.cfg] > sio2
Enter label for type 1 : Si
Enter label for type 2 : O
Enter output file name [.xyz] > sio2

v" To plot .xyz file by Jmol

Excecute Jmol and open “sio2.xyz.



